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GETTING STARTED - SURVEY PART 1

1. After identifying the name of your institution, you need to initially identify the discipline (or
‘profession”) for which you are completing each survey (as per the Detailed Instructions in the
survey).

It is then recommended that you save the survey by clicking the ‘Save file and begin survey’
button:

Save file and begin survey

The survey will automatically generate a file name (i.e. the name of your education provider, and
the discipline you have chosen) [Note. you will need to chose the Directory (and Folder) in which
you save the file].

Throughout the survey you can save it using the ‘save file’ button that appears on each page:

Save File

2. The survey has been designed to try to assist and guide the user where possible.

a. For example, the survey has been pre-populated with course information identified by the
NHWT as likely to lead to professional entry across each discipline of interest [Note. This
information has been sourced from 2007 course information (provided by education providers
to DEEWR), as well as information published on relevant registration board websites. Users
need to confirm or modify this information].

b. Throughout the survey, the ‘light blue-green’ cells represent information that has been either
pre-populated (e.g. course information), or automatically generated by the survey tool based
on information entered by the user in a preceding question.

Table 1. Current Courses identified

DEEWR Course Course N : Level "Comect' & | Full-time, Part- | Yearlevels in
Codes Ol elte AL e offered 2010° | time or Both? course?
1) Bachelor of Pharmacy Bachebr I LCick fordrog downlw b for o

c. ‘Light yellow’ cells represent area where we would like you to enter information in tables. To
assist the user there are a variety of functions in these yellow cells, for example: Drop down
menus; Tick boxes; or Free text

[Note. For tick boxes and drop down menus you can modify your response with the right
mouse button. Any information that is entered in a yellow cell can be removed by using the
'DELETE' key].

It Bl Bt Rl e bt Bt B bt S bl Lt s

Table 2. Current courses - Revisions or additions

DEEWR Course S . Lo ull-time, Part- Year levels in
Codes P time or Both?
1) Click for drop down | lick for drop down | Click
2) Bachelor
3) Graduate Diploma
s Fostgraduate Diploma
b Master
Doctorate

3. You will then need to confirm and/or add relevant courses in Table 1 or Table 2 .

a. Either of these tables may be blank for particular users, however it is important that the
combined information in Table 1 and Table 2 reflects all professional entry courses related to
the discipline for which that survey is being completed (Some surveys may contain only one or
two courses. For others this may be 10 or more professional entry courses across multiple
campuses).




4. Table 3 is required to confirm the length of a standard course taught at different academic levels
for the chosen discipline. This is because, for example, some courses have a ‘fast track’ or ‘credit
entry’ stream that is shorter than the standard course. Some courses are also taught as part of a
double degree which taken together is longer in duration than a single degree.

Slangara year |evers

Table 3. Course Level: Number of valid courses offered at this level (round up to whole
yeary
Bachelor 0 Cllick for drop down
Post Graduate/ ) o
Graduate Diploma ’ =1op goun
Master 0 Drop down
Doctorate 0 Drop down

SURVEY PART 2-5

1. The information for Part 2 through to Part 5 will be based on the information you enter in Part 1 -
Table 1-3.
a. Questions for the remainder of the survey will be generated based on the course levels that
are identified in Part 1 of the survey, as well as the length of a standard course at each level
[Note. See Detailed Instructions — professional entry courses are offered at more than one
level at some institutions].

Profezsional Entry Course Levels (from PART 1)
BACHELOR
MASTER

POSTGRADUATE/GRADUATE
DIPLOMA

N

Each Part starts on a new worksheet to make coordination of survey responses easier (e.g. a
‘survey coordinator’ may like to complete information for one Part while they are waiting for
information related to another Part).

3. Shaded (or ‘greyed out’) cells indicate that, based on the previous answers in your survey, these
cells are not to be filled out.

4. The survey automatically links questions. Also, for some questions extra rows are created
depending on how much information is entered. If you have completed a question and there is still
a blank yellow row that is OK - please continue with the next question.

5. Purple cells represent examples.



TROUBLE SHOOTING (EXCEL 2003)

Enabling macros in Excel 2003
Excel 2003 is usually set to a Medjum security level by default. If so, you will see a prompt when
you open the survey, similar to the one shown below.

Security Warning

"Si\Clients&-F\Department of Human Services - Victoria\WHWTPO36 - Clinical
tfraining\Data'Data surveyTestinglAlex testing 26 Octh\260ct2009-NHWT
survey_final5_unpackaged.xls” contains macros,

Macros may contain viruses, Itis usually safe to disable macros, but if the
macros are legitimate, you might lose some functionality.

i Disable Macros ] [ Enable Macros ] [ Mare Info

You should click Enable Macros.

If your security setting is not set to Medium, read the section Setting macro security level in Excel
2003 below.



Excel 2003 - Setting macro security level
To use the survey, macro security should be set to Medium.
To set macro security to Medium follow the steps below:

1. Go to the Tools menu at the top of your Excel window.

2. Open the Tools menu and go to Macros.
3. Choose Security from the Macros menu.

Microsoft Excel - Book

sy ljiha Q’:Iit View Insert Format | Tools | Data Viindow Help Muance POF  Adobe PDF
AR = NI W RTIES o e F7 gl - @ v Wi |2
: Arial 10 5 |oEy s K Researh.. Alt+Click T ﬁ.-! 1ol
5 : ; Errar Checking... 1 e e
; « Chedk Format [%’lf;enber Across Selecti @ b H— A1 4l sheets (%l Zoom All Sheets ] Normal
Fg o & Speech 3
v T
A | B | & | Shared Workspace... | H | | | J | kK
1 Share Warkbook. ..
2
T Track Changes 13
__{ Campare and Merge Workbooks. .,
i Protection ]
&
T Online Collaboration 3
8 Goal Seek. ..
% Scenarios...
o Formula Auditing 3
12 Solwer. ..
13 ;
Era Macro b | | Macros... Alt+F8
15 Add-Ins... @  Record New Macro...
% % AutoCorrect Optionz. .. | Security. .,
E Customize. ., # Visual Basic Editor Alt+F11
| 19 Options... 08 Miosoft Script Editor  Alt+3hift-+ 11
%_ Data Analysis. .. : : : i

4. Choose Medium from the Security Level tab. You also have the options of Very High, High,
and Low. For most users Medium is recommended, although the survey will also be usable
on a low setting .



| Security Level LIM

{3 Wery High. Only macros installed in trusted locations will be allowed
to run. all other signed and unsigned macros are disabled, |

{3 High. Only signed macros from trusted sources will be allowed to
run. Unsigned macros are automatically disabled,

@Emedium. You can choose whether or not to run potentially unsafe
Macras,

7 Low (not recommended). You are not protected from potentially
unsafe macros, Use this setting only if yvou have virus scanning
software installed, or you have chedked the safety of all documents
you open,

[ Ok ][ Cancel ]

5. Click the OK button and restart Excel by closing the program and re-opening it.

Your macro security level should now be set to medium.

Setting macro security level in Excel 2003 using registry changes (advanced)

If for some reason you are unable to change the security setting from within Excel, you may find
that your network administrator has set the security level. You may need to either contact your
network administrator, or complete the survey on a computer where you can change the settings.



TROUBLE SHOOTING (EXCEL 2007)
Excel 2007 - Enabling macros

Excel 2007 is usually set to the Disable all macros with notification security level by default. If so,
you will see a banner with an orange shield and the words Security warning in bold, similar to the
one below.

Hiorne Insert Page Layout Formulas Data

— o~ .
)~
L
[ Horme Insert Page Layout Formulas Erata
3 * Record Macro |: = RN pran
e
i {5 Use Relative References | & 8 Gl view
Visual Macios : : Irisert: [Cresign
g 3\ Macro Security + | Mode | B Bun

=
L

Contiols

@ Security Warning Macros have been disabled, Options...

Click this banner and select Enable this contentin the box that appears, as shown below.

Microsoft Office Security Options

Security Alert - Macros & ActiveX

Macro

Macros have been disabled. Macros might contain viruses or other security hazards. Do
not enable this content unless you trust the source of this file,

Warning: It is not possible to determine that this content came from a
trustworthy source. You should leave this content disabled unless the 3
content provides critical functionality and you trust its source.

Maore information

File Path:  S:\...g%alex testing 26 Qct\260ct2009-MNHWT survey_final5_unpackaged. xls g

) Help protect me from unknown content {recommended) I

& En

Open the Trust Center L Ok ] [ Cancel ] i

If your security setting is not set to Disable all macros with notification, read the section Setting
macro security level in Excel 2007 below.



Excel 2007 - Setting macro security level

To use the survey, macro security should be set to Disable all macros with notification. To set
macro security to Disable all macros with notification follow the steps below:

1. On the Developer tab, click the Macro Security button in the Code group.

.ﬁa\t * oz B e DR Bookz - Micr
)

™ Home Insert FPage Layout Farmulas Data Review View Developer

=3 Record Macro |"._;1 & 3 Properties @ :% Map Praperties i‘%Import

= : ~References % 5 EEm Gl iew Code = 5 Expansion Packs ) Export

Visual Macpds Insert Besign SOure: . o

Basic ._ﬁ hiacro security | - Made 7 Run Dialog "-5 Refresh Data

Code Controls L

2. Choose Disable all macros with notification from the list under Macro Settings.

Trust Center EI['E

Trusted Publishers

Macro Settings

Trusted Locations X X .
For macros in documents not in a trusted location:

Add-ins O Disable all macros without notification

(%) Disable all macros with notification!

ActiveX Settings

O Disable all macros except digitally signed macros

‘Macro Settings d () Enable all macros [not recommended; potentially dangerous cade can run)

Message Bar Developer Macro Settings

External Content
|:| Trust access to the VBA project object model

Privacy Options

3. Click the OK button

Your macro security level should now be set to Disable all macros with notification.



Excel 2007 - Compatibility error messages

Users working in Excel 2007 may see compatibility error messages similar to the one shown below
when saving the workbook using the usual method. To proceed, click the Continue button.

Microsoft Office Excel - Compatibility Checker E]E|

The following features in this workbook are not suppaorted by earlier versions
of Excel. These features may be lost or degraded when you save this

'ﬂ workbook in an earlier file format. Click Continue to save the workbook
anyway. To keep all of your features; dick Cancel, and then save the file in
one of the new file formats. i

SUMMmary Mumber of occurrences

i | Significant loss of functionality Q i |

This workbook contains data in cells outside of the row and 16 |
column limit of the selected file format. Data beyond 256 (IV) . Hel B
columns by 65,536 rows will not be saved. Formula dng Hed
references to data in this region will return a #REF! errar, i

I Location: 'PART 2a Clinical Placements' I
This workbook contains data in cells outside of the row and 4
column limit of the selected file format, Data beyond 256 V)
__columns by 65,536 rows will not be saved, Formula b | ;
. Check compatibility when saving this waorkbook,
] [ Copy to Mew Sheet | Continue J I Cancel ] [
|
FURTHER QUERIES

If you need assistance with any aspect of the survey please call Chris Ingamells or Gerri Lim on

(03) 9092 2069, or email your enquiry to nhwt@dhs.vic.gov.au (please include the words ‘Survey
Query’ in the title).




